### Contents

**Starting MS Excel** .................................................................................................................. 2

**The MS Excel Window** ......................................................................................................... 3

**Title Bar** .................................................................................................................................. 3

**Office Button** .......................................................................................................................... 4

- Saving Your Work .......................................................................................................................... 4
  - For the first time ............................................................................................................................. 4
  - While you work .............................................................................................................................. 4
  - Backing up your work .................................................................................................................... 4
- MS Excel 1997-2003 File Format Compatibility .................................................................... 4
- Printing ...................................................................................................................................... 5

**Quick Access Bar** .................................................................................................................... 6

**Status Bar** ................................................................................................................................ 6

**What are Spreadsheets?** ......................................................................................................... 6

**Cell References: Rows and Columns** .................................................................................... 6

**Working With Data** .................................................................................................................. 7

- Text ........................................................................................................................................... 7
- Number ...................................................................................................................................... 7
- Boolean ...................................................................................................................................... 7
- Date and Time .............................................................................................................................. 7
- Formula ...................................................................................................................................... 7
  - Constants ................................................................................................................................. 8
  - Mathematical Operators ......................................................................................................... 8
  - Cell References and Cell Ranges ............................................................................................. 8
  - Functions ................................................................................................................................. 8
  - Creating Formulas .................................................................................................................. 8
  - Calculating with Functions .................................................................................................... 8
  - The IF function ........................................................................................................................ 10
- Copy (Cut), and Paste ................................................................................................................ 11
  - Copy/Paste with AutoFill ....................................................................................................... 11
  - Relative Addressing ............................................................................................................... 11
  - Absolute Addressing .............................................................................................................. 12

**Ribbons** ................................................................................................................................... 12

**Home Ribbon** .......................................................................................................................... 13

- Text Formatting .......................................................................................................................... 13
- Number Formatting ..................................................................................................................... 13
- Sorting ....................................................................................................................................... 14
- Cell Formatting .......................................................................................................................... 14
Insert Ribbon .........................................................15
Illustrations ...........................................................................................................15
Charts ......................................................................................................................15
Microsoft Excel 2007™

Microsoft Excel 2007™ is an electronic spreadsheet software package that allows you to organize data in a tabular format, perform mathematical calculations, and analyze data. This software includes functions, formulas, and charts. It is commonly used in business, engineering, mathematics, and statistics. This tutorial covers the basic functionality of the software.

Starting MS Excel
To start MS Excel click on the Start Menu on the bottom left corner of your desktop and select **Start**→**All Programs**→**Microsoft Office**→**Microsoft Office Word 2007**.
The MS Excel Window

The MS Excel 2007 interface brings out all the functionality of the software using tabs rather than drop-down menus. The main work area is called a spreadsheet where you can communicate your data using functions, formulas, and charts. The highlighted cell is called the active cell and is the current place where you can enter a value or a formula. We will describe the parts of the interface in the following sections.

Title Bar

The title bar contains (left to right) the Office Button, Quick Access Toolbar, the filename of your document (middle), and minimize, restore down, and close buttons (right).
Office Button

The Office button (located at the top left of the MS Excel Window) is a drop-down menu of commands (see figure on the right) that you can use on MS Excel files. It includes creating a new file, opening an existing file, saving, and printing. A menu choice with a right pointing arrow expands to another menu of command choices.

Saving Your Work

For the first time
To save your document for the first time, select the **Save As → Excel Workbook** command. Fill in the entries for the **Save As** pop-up window and click the **Save** button when you are done:

Save in
Choose the location to place your file, i.e. to your desktop, a folder on the hard disk, flash drive, etc.

File name
Choose a name for your file. Note, do not include a file extension.

Save as type
Make sure ‘Excel Workbook’ appears here. Otherwise, select it in the drop down menu.

While you work
After saving for the first time, you will only need to select the **Save** menu choice for subsequent saves. An even faster way to do this is to use the hot button provided on the Quick Access Toolbar. Remember to save your document frequently.

Backing up your work
You can also save your work a second time in a different place. This is called “backing up your files”. Follow the directions under **Saving Your Work: For the first time** to create a second copy of your file. Although not necessary, it is suggested just in case you lose your first copy. Save to this backup copy every so often as a version to fall back to.

MS Excel 1997-2003 File Format Compatibility
MS Excel 2007 is backwards compatible because you are able to edit and save your MS Excel 1997-2003 document files. When an MS Excel 1997-2003 file is opened for editing using the MS Excel 2007 software, the window’s title bar will indicate this by displaying [Compatibility Mode] next to the file name (see figure below). The document will be saved using the MS Excel 1997-2003 file format when you use the **Save** command.
You can save an MS Excel 1997-2003 document to the new MS Excel 2007 file format using the **Save As → Excel Workbook** command (see figure on the left). Note, you can save an MS Excel 2007 document to the older MS Excel 1997-2003 file format using the **Save As → Excel 97-2003 Workbook** command (see figure on the right).

**Printing**
When you are ready to print your document on paper (called a *hard copy*) choose the command **Print** from the Office Button. Fill in the entries to the **Print** pop-up window and click the **OK** button when you are done:

**Name**
Choose the title of the printer you are sending your document to.

**Page range**
Lets you choose if you want to print your entire document or just a particular page or pages. For example, to print pages 1 through 5 of your 13 page document, you can type 1-5 in the **Pages** tab.

**Copies**
The **Number of copies** tab allows you to select how many duplicates of your document you want to print.

You can view your document conveniently on the screen as it will appear on paper before you send it to the printer using **Print → Print Preview**. It is a good idea to get in the habit of using this feature before you decide to create a hard copy.
Quick Access Bar
The commonly used commands Save, Undo, and Redo can be found at the top left of the MS Word window as hot buttons (see below from left to right). You can customize this toolbar using the down arrow drop down menu (rightmost).

Status Bar
The Status bar is located at the bottom of the MS Excel window. You can quickly choose how to view your data (see 1) using the hot buttons for Normal and Print Layout views. A slider allows you to zoom in or out of your document (see 2).

What are Spreadsheets?
A spreadsheet is a group of cells organized into columns and rows containing data.

Cell References: Rows and Columns
A row is a set of cells in the horizontal direction. Each row is numbered where the top-most row is numbered as 1. You can change the height of a row by moving your mouse over the row line and dragging it to your desired height.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

A column is a set of cells in the vertical direction. Each column is labeled with letters. After column Z, the columns are labeled with AA, AB, AC, etc. You can change the width of a column by moving your mouse over the column line and dragging it to your desired width.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
A cell is a single box that is the intersection of a column and row. Each cell is named according to its column label and row number, called a cell reference. For example, the highlighted cell shown below is named cell B3. The name box is located at the top left corner of the worksheet (see red arrow below) and displays the cell reference of the active cell.

![Cell Reference](image)

**Working With Data**

You can enter text, numbers, Booleans, dates, times, and formulas into a cell.

**Text**

Text is any combination of numbers, spaces, and non-numeric characters. For example, Excel treats the following entries as text: 10AA109, 127AXY, 12-976, 208 4675. All text is left-aligned in a cell by default.

**Number**

A number can contain only the following characters: 0 1 2 3 4 5 6 7 8 9 + - ( ) / . All numbers are right-aligned in a cell by default. Excel ignores leading plus signs (+) and treats a single period as a decimal. You can use the following characters to format the number: , $ %, e.g. 1,000, $13.25, and 57%. All other combinations of numbers and nonnumeric characters are treated as text.

**Boolean**

The values TRUE and FALSE are special values called Boolean values. A Boolean expression in a formula will evaluate to one of these two values. Note that surrounding either TRUE or FALSE with quotes, e.g. “TRUE”, does NOT indicate a Boolean value, rather a text value.

**Date and Time**

The way that a date or time is displayed on a worksheet depends on the format applied to the cell. All dates and times are right-aligned in a cell by default. A date may be a short date, e.g. **11/27/2008**, or a long date, e.g. **Thursday, November 27, 2008**. Excel only recognizes dates staring from January 1, 1900. Also, Excel treats dates as numbers where 1/1/1900 is the same as 1, 1/2/1900 is the same as 2, and so on. A time is formatted as hours, minutes, seconds, and AM/PM, e.g. **1:12:04 PM**. Times are also numbers, where each time is a number between 0 and 1. For example, midnight is 0 and noon is 0.5, and 11:59:59 PM is 0.999988425925926. If Excel cannot recognize a date or time that you enter, then it is treated as text.

**Formula**

A formula is a mathematical expression that evaluates to a single value. It can be used to perform a useful calculation in a cell. You can construct a formula using any mix of the following components: constants, mathematical operators, cell references and ranges, and functions.
Constants
A constant is a number or text value that does not change.

Mathematical Operators
A mathematical operator specifies a calculation. Common operators are: + (add), - (subtract), * (multiplication), and / (division).

Cell References and Cell Ranges
A cell reference in a formula evaluates to the value contained with that cell. A range of cells can be specified using the colon : symbol. A range can contain a row, a column, or a block of cells. As shown below, the syntax A1:C1, A1:A5, and B2:C5 specify ranges along a row, a column, and a block of cells, respectively.

Functions
A function is a pre-defined formula in Excel that you can insert into your formula. Each function is specified by its name and input arguments and evaluates to a single value.

Creating Formulas
To create a basic formula, use the following procedure:
1) Select with your mouse the cell in which you would like to insert your formula, e.g. A1 in the figures below.
2) All formulas must start with an = sign.
3) After you type the = sign, type your syntactically correct formula.
4) Click Enter when you are done.

If you type your formula directly into the active cell then it will be simultaneously displayed in the Insert Function box. Alternatively, you may type your formula into the Insert Function box. After you press Enter, the cell will display the evaluated value of your formula and the Insert Function box will display the formula (see figure on the right).

Calculating with Functions
One or more functions may be specified in a formula to help calculate a desired final value in a cell. The most commonly used functions can be found under the AutoSum button, which looks like a summation symbol in mathematics (see below) and found on the Home tab under the Editing section (or the Formulas tab under the Function Library section).
Consider the following table of student names and homework scores. The block of cells A1:D5 contain constant values (text and numbers).

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Name</td>
<td>HW#1</td>
<td>HW#2</td>
<td>HW#3</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Doe, Jane</td>
<td>100</td>
<td>87</td>
<td>84</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Smith, Robert</td>
<td>95</td>
<td>90</td>
<td>79</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Jones, Emily</td>
<td>94</td>
<td>92</td>
<td>88</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Li, Dave</td>
<td>76</td>
<td>69</td>
<td>93</td>
<td></td>
</tr>
</tbody>
</table>

To compute the SUM over the column of HW#1 scores in cell B7 perform the following:
1) Click on the cell B7 to make it the active cell.
2) Click the AutoSum button’s drop-down menu and choose Sum.
3) Highlight cells B2 through B5 with your mouse (Excel will outline the cells in the chosen range). The formula shown in cell B7 will be =SUM(B2:B5), where the function called SUM is given the range B2:B5 is its input argument.
4) The cell B7 will display evaluated value (final answer) for the formula.

The AutoSum button contains other commonly used as listed below:
- **Sum**: Adds all the numeric values contained in the cells specified in the input argument.
- **Average**: Averages all the numeric values contained in the cells specified in the input argument.
- **Min**: Determines the smallest numeric value among all the cells specified in the input argument.
- **Max**: Determines the largest numeric value among all the cells specified in the input argument.
- **Count**: Counts how many cells contain numeric values in the input argument.
Use these functions to write formulas that compute the indicated computation in the table above for HW#1 to produce the following results:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Name</td>
<td>HW#1</td>
<td>HW#2</td>
<td>HW#3</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Doe, Jane</td>
<td>101</td>
<td>82</td>
<td>84</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Smith, Robert</td>
<td>95</td>
<td>90</td>
<td>79</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Jones, Emily</td>
<td>94</td>
<td>92</td>
<td>88</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Li, Dave</td>
<td>78</td>
<td>89</td>
<td>99</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Total</td>
<td>567</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Average</td>
<td>91.75</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Min</td>
<td>78</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Max</td>
<td>108</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Median</td>
<td>94.5</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

To find the function to compute the median of the HW#1 values, use the AutoSum drop-down menu to choose the More Functions... option. When the Insert Function pop-up window appears, choose Statistical under the Or select a category drop down menu. Find the MEDIAN function in the Select a function box using the scroll bar. Note that you can also open the Insert Function by clicking on the Insert Function icon.

The IF function

The IF function is a useful function in that it allows you to place one of two values in a cell based on a decision. For example, if you would like to place either the text value “YES” or value “NO” in E2 based on the decision whether Jane Doe has the highest HW#1 score, then you can enter the formula: =IF(B2 = B10, "YES", "NO") (see the left figure). The IF function has up to three comma separated arguments:

- **IF( <Boolean expression>,**

- **<Expression when TRUE>,**

- **<Expression when FALSE>)**

A Boolean expression that evaluates to either TRUE or FALSE. You can use relational operators (<, >, =, <=, >=) and the boolean functions AND, OR, and NOT to build your Boolean expression.

If the first argument evaluates to TRUE, then this expression is evaluated and the final value will display in the cell. This expression can evaluate to any value.

If the first argument evaluates to FALSE, then this expression is evaluated instead. This expression can also evaluate to any value. This argument is optional.
Copy (Cut), and Paste

You can copy (or cut) the contents of a cell and then paste the contents to a different cell. To copy: select the cell you want to copy contents from, click the copy button (found under the **Home tab** in the **Clipboard section**), select the cell you want to paste to, and finally click the paste button. Note: To perform this operation quicker use the hot key sequence `Ctrl-c` to invoke the **copy** (use `Ctrl-x` to invoke a **cut**) and then `Ctrl-v` to invoke a **paste**.

Copy/Paste with AutoFill

To copy the contents of a cell to neighboring cells (along a row, column, or block of cells) use the **AutoFill** feature, which is **the square located at the bottom right corner of the active cell**. For example, to copy the number 22 in cell A1 (see left figure) to the cells in A2:A4, first click on the cell to activate it. Move your cursor over the AutoFill square so that your mouse pointer turns into a thin cross. Click down on the square with the left mouse button and drag your mouse to A4 (see middle figure). Release you’re the left mouse button and you will see the result of the copy/paste in A2:A4 (see right figure).

Relative Addressing

When you copy/paste formulas, Excel will preserve the structure of the formula but may change the cell references in the formula according to the direction in which the copy/paste occurs, called **Relative**.
**Addressing.** For example, if we copy the contents of cell B7 (=SUM(B2:B5)) and paste it across the row to cell D7, then cell D7 will contain the updated formula =SUM(D2:D5), which is the total of all the HW#3 scores (see the left figure). Using the Autofill feature again across each row, we can copy/paste the formulas at the bottom of the table to compute values for HW#2 and HW#3 (see the right figure).

**Absolute Addressing**

We can copy/paste the formula in cell E2 down the column to E5 to determine whether or not each student has the highest HW#1 score. If copy/paste the formula =IF(B2 = B10, "YES", "NO") in cell E2 down the column, then the resulting formula in cell E5 will be =IF(B5 = B13, "YES", "NO"). This formula is **INCORRECT** since we would like to compare the contents of cell B5 (Dave Li’s HW#1) with the maximum over all HW#1 scores in cell B10. The change of the cell reference change from B2 to B5 due to **Relative Addressing** is desired, but the change from B10 to B12 is not! We can indicate that a cell reference in a formula must not change in a copy/paste by placing the $ symbol next to the row and column of the cell reference, called **Absolute Addressing.** Thus, the formula in cell E2 should be re-written as =IF(B2 = $B$10, "YES", "NO"). After this formula is copy/paste down the column to cell E5, then cell E5 will contain the formula =IF(B5 = $B$10, "YES", "NO").

**Ribbons**

All MS Excel commands are organized into groups of related commands called **ribbons.** Each ribbon is displayed by clicking its tab found below the title bar. Each collection of commands found in a ribbon is further grouped into sections. A command is invoked by clicking on its hot button. The settings for a command are chosen by either using a drop-down menu or clicking on the Dialog Box launcher button.
of a section, which appears at the bottom right of the section. A dialog box may have additional settings that do not appear on the ribbon.

**Home Ribbon**
The Home ribbon is the first place to start because it contains commands related to editing the content of a cell and the worksheet.

![Home Ribbon Image]

**Text Formatting**
Format text values using the commands in the **Font Section** such as the font type, font size, color, bold, italics, etc. Use the All Borders button to change the border attributes of blocks of cells.

![Font Section Image]

Position values in a cell both horizontally and vertically. If the text you type in a cell is longer than the width of the cell use the **Wrap Text** button to fit the text by adjusting the size and shape of the cell. If you would like to merge text in adjacent cells, then highlight all the cells and then press the **Merge and Center** button.

![Alignment Image]

**Number Formatting**
Format number values as you would like them to be displayed using the **Number** section. You can determine the number of digits to be displayed after the decimal place as well.

![Number Section Image]
Sorting
Sort a table of data by first highlighting all the cells in the table (including any headings) and then select Sort & Filter from the Editing section and choose the order to sort the table. We sort the following table by Name in the following example.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Name</td>
<td>HW1</td>
<td>HW2</td>
<td>HW3</td>
<td>Score</td>
</tr>
<tr>
<td>2</td>
<td>Doe, Jane</td>
<td>100</td>
<td>87</td>
<td>84</td>
<td>YES</td>
</tr>
<tr>
<td>3</td>
<td>Smith, Robert</td>
<td>95</td>
<td>90</td>
<td>75</td>
<td>NO</td>
</tr>
<tr>
<td>4</td>
<td>Jones, Emily</td>
<td>94</td>
<td>92</td>
<td>88</td>
<td>NO</td>
</tr>
<tr>
<td>5</td>
<td>Li, Dave</td>
<td>78</td>
<td>89</td>
<td>93</td>
<td>NO</td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Total</td>
<td>367</td>
<td>358</td>
<td>344</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Average</td>
<td>91.75</td>
<td>89.5</td>
<td>86</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Min</td>
<td>78</td>
<td>87</td>
<td>75</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Max</td>
<td>100</td>
<td>92</td>
<td>93</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Median</td>
<td>94.5</td>
<td>89.5</td>
<td>86</td>
<td></td>
</tr>
</tbody>
</table>

Cell Formatting
Excel provides pre-defined table formatting using the Styles section. Highlight your table of data and then use the Format as Table drop-down menu to choose a table format for the table heading and entries (see the top table, where the heading is colored black the data in blue). Change the look of groups of cells with the Cell Styles drop-down menu (see bottom table, where the cells are colored in light red).

Insert or delete groups of cells or an entire row or column using the Cells section.
Insert Ribbon

Illustrations
The drop-down menus in the Illustrations section allow you to insert pictures from image files, clip art, and drawings onto your worksheet.

1) To place the illustration on your worksheet, click on it somewhere in the middle with your left mouse button and then drag it to the desired location on the worksheet.
2) Resize the illustration by dragging a side or corner of its bounding box.
3) Use the Format ribbon to change attributes about the picture.

Charts
Create a chart of your data using one of the drop-down menus in the Charts section.

1) Highlight the cells that contain your table of data
2) Choose the chart type that is most appropriate for your data.
3) Position and resize the chart on your worksheet as you would an illustration.
4) Use the Chart Tools ribbon to customize your chart or choose a new chart type.